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Opstarten Rational Rose

Klik Start >
Programma’s >
Rational Suite
DevelopmentStudio
- Rational Rose
Enterprise Edition

‘Windows =000 Professional

st || & () 50 @ || el B - B | Mot -t . [$ERE o
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Kiezen van een Framework

Na het opstarten verschijnt het volgende scherm (daadwerkelijk scherm kan licht afwijken).

4% Rational Rose - {untitled) =] =l

File Edit View Format Browse Report Query Toclsddr-- tui—d-. Ll |

Create New Model

DdH| ‘=R &R0 R
5] [untitied) W W Rational Rose
D Use Case Yiew E :

-3 Logical View

#1-°3 Component Yiew B %I Hew |EHIS“"19| Hecentl

{6 Deplayment View S| E‘

“{@g) Model Propetties rr m @
&5 EJEF k
_ Tamewarl
. § Fral
|
‘ 79 J 2
E @
o & J2SE1.2 J2SET1Z jdk-11E
oo A oJ 2
o EN
jdk-12 11 Make New
HO Framewark,
- ﬁ W  ie; A
@]

. [~ Don't show this dialog in the future

G
® @

122028 [[Update Model F‘ropen!es]] |

1220291 [[Update Model Properties])

12:20:29]  [[Update Model Properties])

12:20:29]  [[Update Model Properties]) J
=l

Lo
A

12:20:29]  [[Update Model Properties])

;I LA ¥, Log /
For Help, press F1 |Default Lanquage: Delphi [ [

Voor het creéren van een model kan een Framework gekozen worden (er kan ook op Cancel geklikt
worden om te starten zonder Framework). Een Framework bevat al voor gedefinieerde standaard
classes, zo bevat de Delphi Framework bijvoorbeeld al alle normale Control Classes (zoals
bijvoorbeeld Forms). Hieronder een opsomming van de Frameworks en een korte beschrijving.

Framework Beschrijving

Delphi Framework De Delphi Framework bestaat uit een volledig reverse engineerd model van
(Mits Rose Delphi Link | de volgende Delphi 5 bibliotheek bestanden:

geinstalleerd is)
Classes, Controls, Dialogs, Forms, Graphics, Messages, SysUtils, System,
Windows.

Om gebruik te maken van andere Delphi bibliotheken moet de unit categorie
file (.cat) uit de Delphi Framework directory in de Rose Delphi Link installatie
directory gehaald worden. Normaal zou dat de volgende directory zijn:

C:\Program Files\Ensemble\Rose Delphi Link 3.x\Delphi Framework

EJB Framework (Mits | De EJB Framework bestaat uit een backbone voor de JAVA en EJB

Rose Delphi Link packages.

geinstalleerd is)

J2EE Dit is een framework voor JAVA

Versie : 0.3 5 21 mei 2003
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J2SE 1.2

Dit is een framework voor JAVA

J2SE 1.3

Dit is een framework voor JAVA

JDK - 166

De JDK 1.1.6 Framework bevat een reverse engineerd model van de JDK
1.1.6 classefiles. Dit framework bevat alle classes die gevonden worden in
de JAVA package, ook bevat het een aantal classes die gevonden worden in
de SUN package.

Om de framework laadtijd te beperken zijn alle privé attributen, relaties en
operaties weggehaald van de classes. Deze zijn niet nodig voor het
gebruiken van dit framework als een beginpunt voor het bouwen van classes
gebaseerd op de JDK.

JDK - 12

De JDK 1.2 Framework bevat een reverse engineerd model van de JDK 1.2
classes. De classes die dit framework bevat zijn gebaseerd op de in "The
Java™ Class Libraries - Java 2 Platform, Standard Edition, v1.2" beschreven
classes.

Alle privé attributen, operaties en genestelde classes zijn verwijderd, deze
zijn niet nodig voor het gebruik van de framework in een standaard ontwikkel
proces.

Alle eigenschappen gebruikt door de Rose/J add-in voor code generatie zijn
op de standaardwaardes gezet.

JFC - 11

DE JFC 1.1 Framework bevat een gereversed engineerd model van de JFC
1.1 class files zoals te vinden in <Swing Home>\swingall.jar. Dit framework
bestaat uit alle classes die te vinden zijn in de com.java package, ook bevat
het de JDK 1.1.6 files en een klein aantal classes die te vinden zijn in de
SUN package.

Om de framework laadtijd te beperken zijn alle privé attributen, relaties en
operaties weggehaald van de classes. Deze zijn niet nodig voor het
gebruiken van dit framework als een beginpunt voor het bouwen van classes
gebaseerd op de JFC.

Oracle8 Datatypes

De Oracle 8 Datatypes Framework bevat de classes voor de verschillende
Oracle 8 scalar (ingebouwde) datatypes, zoals CHAR, VARCHAR, DATE,
etc.

Rational Unified
Process framework

The Rational Unified Process Framework is een aanvulling op de Rational
Unified Procces. Dit model gebruikt een set van packages in de standaard
Rose “views” om de artifects gedefinieerd door het proces te organiseren en
te managen door Rose.

VB6 Standard

De VB6 Standard Framework beidt ene constantes en objecten gedefinieerd
door de Visual Basic 6 (VBA), herbruikbare VB 6 objecten en procedures
(VB),VB6 runtime objecten en procedures (VBRUN) en de OLE Automationd
bibliotheek (STDOLE)

VC6 ALT 3.0

De ATL 3.0 Framework bevat de ATL 3.0 classes. Als je besluit om geen
model te maken gebruikmakend van dit framework dan kunnen deze classen
nog worden geimporteerd in een bestaand model via Tools - Visual C++ >
Quick Import ATL 3.0.

Om laadtijd van de framework te besparen zijn de ATL classes afgeleid van
COM SDK interfaces niet toegevoegd aan dit framework.

VC6 MFC 6.0

De MFC 6.0 Framework bevat de MFC 6.0 classes. Deze classes zijn vereist
om gebruik te maken van de MFC mogelijkheden van de Visual C++ Addin.
Als je besluit om geen model te maken gebruikmakend van dit framework
dan kunnen deze classes nog worden geimporteerd in een bestaand model
via Tools = Visual C++ - Quick Import MFC 6.0
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Belangrijk lees dit eerst voordat je een diagram maakt!

Omdat de in Rational Rose ontwikkelde diagrammen rechtstreeks in Word zullen worden geplakt (zie
verder op in deze handleiding), is het belangrijk dat op de diagrammen staat aan gegeven welk
diagram het is, waar het diagram te vinden is, wie de persoon is die het diagram het laatste heeft
bijgewerkt, wanneer het diagram de laatste keer is bijgewerkt en welke versie het is. Daar toe zullen
we een Note toevoegen (zie de specifieke diagrammen voor de locatie van de Note).

Activity Persoon toevoegen
Use Case View -> Persoon toevoegen - > State/Activity Model

Maarten van Wesel, 14 mei 2003, Versie 1.0

Voorbeeld van opmaak note

Specificaties v.d. Note

Het lettertype is Ariel, tekst grote 8 en de tekenstijl is cursief.
Deze instellingen zijn te maken door de note te selecteren > Format (boven in de menubalk) >
Font....

BELANGRIJK: DOCUMENTATIE MET DIAGRAMMEN
ZONDER DEZE NOTE WORDEN NIET
GEACCEPTEERD!!!

WERK DE NOTE NA IEDERE
VERANDERING BIJ!!!
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Ga naar het Use-Case diagram door op het plusje voor Use-Case View te klikken en daarna te

dubbelklikken op Main.

Er zal een scherm verschijnen waar de onderstaande weergaven een deel van is, mochten er iconen
ontbreken in de werkblak kan deze (indien nodig) via rechter muisklik op de werkbalk - Customize
worden aangepast. Je zult hier zien dat er nog meer toegevoegd kan worden, maar de onderstaande
zijn de belangrijkste, waarschijnlijk zul je van de onderstaande set niet alles nodig hebben.

0 Dﬁ.| % _? Eﬁﬁ'y Selection Tool

AN

|:| Buziness Use-Caze Molel
|:| IJse-Case Model

#-CJ Logical View

#-CJ Component Wiew
E]--- Deployment YWiew
(@8 Model Properties

0

AR

[

ST T @M @ m o

L

e & O e [

Text Box
Note
Anchor Note to ltem

K Class
< Parameterized Class

£ Class Utility

/ Parameterized Class Utitity
< Association

Undirectional Association
Aggregation

Undirectional Aggregation
\ Association Class
Generalization
Dependency of Instantiates
Package

Actor

Use-Case

Interface

Realize

Refine Use-Case

Extend Use-Case

2z

Browser

Include Use-Case

Voor het toevoegen van bv. een Use-Case klik je deze aan op de werkbalk en vervolgens klik je op de
plaats waar deze in het diagram moet komen, vervolgens kun je de naam invoeren.

Voor het toevoegen van een associatie (bv. Association, Aggregation etc) klik je deze aan op de
werkbalk en vervolgens klik je op de zender (bv.de Actor of de Use-Case) en trek je naar de ontvanger

(bv. een Use-Case).

Hieronder volgen stappen om de drie hoofdattributen van een Use-Case Diagram (Use-Case, Actor,

Assocation) te verfijnen.

Versie : 0.3
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Use-Case

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Use-Case, deze in de diagram >
rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.

Use-Case beschrijving toevoegen

Een Use-Case beschrijving moet gemaakt worden als een extern bestand (bv. als Word document).
Hierna kan het op aan de Use-Case worden gekoppeld. Voor het toevoegen van een extern bestand
aan een Use-Case, selecteer de Use-Case in de diagram - rechter muisklik > Open Specification
hier na klik je in het nu verschenen scherm op het tabblad Files vervolgens rechter muisklik je op het
witte vlak - Insert File > selecteer de file > Open > Ok.

Actor

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Actor, deze in de diagram - rechter
muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte documentatie
worden getyped.

Veranderen stereotype

Je kunt een van de gewonen Actor omzetten naar bv. een Business Actor. Selecteer hiervoor de
betreffende Assocation in de diagram - rechter muisklik > Open Specifiation vervolgens kan bij
Stereotype de juiste stereotype worden gekozen.

Association

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Association, deze in de diagram >
rechter muisklik = Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.

Veranderen stereotype

Je kunt een van de gewonen Assocaties omzetten naar bv. een Extend. Selecteer hiervoor de
betreffende Assocation in de diagram - rechter muisklik > Open Specifiation vervolgens kan bij
Stereotype de juiste stereotype worden gekozen.
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Activity/State(Chart) Diagram

Om een Activity Diagram te maken moet er rechts geklikt worden op Use-Case View in de Browser,
hier door wordt een menu zichtbaar. Klik daar in op New 2 Activity Diagram, daarna kan de naam
worden ingevoerd. Dubbelklik op de diagram om hem te openen. Op dezelfde manier kun je een State
Diagram toevoegen alleen klik je in plaats van Activity Diagram op State Diagram.

Deze diagrammen zijn ook toe te voegen bij de Logical View op dezelfde manier als bij de Use-Case
View

Er zal een scherm verschijnen waar de onderstaande weergaven een deel van is, mochten er iconen
ontbreken in de werkblak kan deze (indien nodig) via rechter muisklik op de werkbalk > Customize
worden aangepast. Je zult hier zien dat er nog meer toegevoegd kan worden, maar de onderstaande
zijn de belangrijkste, waarschijnlijk zul je van de onderstaande set niet alles nodig hebben.

D ﬁﬂ{}é E@\@ _? k¢|E| [ Select Tool
/ N\

Text Box

@ hititled) W Note
=/ Use Case View AEC
@ Mai Anchor Note to Iltem
ain =
- % NewClass P State
2 MewlseCase .
- Uselase S| Activity
EI‘*EE| Stateddictivity Model = Start State
- [ NewDiagram .
F-2, Associations End State
-7 Logical Yiew ® State Transition
-] Component Yiew Ve
D : Transition to Self
-9 Deployment Yiew 0
{28 Model Properties Horizontal Synchronization
| Vertical Synchronization
£ Decision
0 Swimlane
=] Object
/ * Object Flow

Browser

Voor het toevoegen van bv. een Activity of Swimlane klik je deze aan op de werkbalk en vervolgens
klik je op de plaats waar deze in het diagram moet komen, vervolgens kun je de naam invoeren.

Voor het toevoegen van een State Transition klik je deze aan op de op de werkbalk en vervolgens klik
je op de zender (bv. een Activity) en trek je naar de ontvanger (bv. een andere Activity), een Transition
to Self voeg je toe door deze aan te klikken op de werkblak en vervolgens op de betreffende Activity te
klikken.

Hieronder volgen stappen om enkele hoofdattributen van een Activity Diagram te verfijnen.

Versie : 0.3 10 21 mei 2003
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Activity

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Activity, deze in de diagram >
rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.

Action toevoegen

Selecteer, voor het toevoegen van een Action aan de Activity, deze in de diagram - rechter muisklik
- Open Specification klik vervolgens op het tabblad Actions , vervolgens rechter muisklik op het witte
vlak > Insert. Er wordt dan Entry actie gemaakt, als je deze wil wijzigen of als je de naam wil
toevoegen, selecteer dan de betreffende actie, vervolgens rechter muisklik > Specification.... Hier
kun je de soort actie kiezen (On Entry, On Exit, Do en On Event).

State Transition/Transition to Self

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Transition, deze in de diagram >
rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.

Event en Arguments toevoegen

Selecteer, voor het toevoegen van Event en Arguments aan de Transition, deze in de diagram >
rechter muisklik > Open Specification hierna kan bij de juiste velden de Event en de Arguments
worden getyped.

Guard Condition, Action, Send Event, Send Arguments en Send Targets toevoegen

Selecteer de betreffende Transition in de diagram > rechter muisklik > Open Specifitation - tabblad
Detail, hierna kun je de betreffende gegevens invoeren.

Toevoegen van meerdere Transitions to Self

Als je een tweede Transition to Self toevoegt zie je er maar een, maar er zijn er echt twee. Om dit
zichtbaar te maken rechter muisklik je op de Transition > Position - selecteer dan Top, Bottom, Left
of Right.

Swimlane

Korte beschrijving toevoegen
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Voor het toevoegen van een korte beschrijving van de Swimlane rechter muisklik boven op de naam

van de Swimlane > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.

Class van de Swimlane selecteren

Voor het selecteren van een Class van de Swimlane rechter muisklik boven op de naam van de
Swimlane rechter muisklik boven op de naam van de Swimlane > Open Specification hierna kun je de
betreffende Class selecteren.

State/Start State/End State

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de State, deze in de diagram = rechter
muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte documentatie
worden getyped.

Action toevoegen

Selecteer, voor het toevoegen van een Action aan de State, deze in de diagram - rechter muisklik >
Open Specification klik vervolgens op het tabblad Actions , vervolgens rechter muisklik op het witte
vlak = Insert. Er wordt dan Entry actie gemaakt, als je de soort Event wilt wijzigen of als je de naam
wilt toevoegen, selecteer dan de betreffende actie, vervolgens rechter muisklik > Specification.... Hier
kun je de soort actie kiezen (On Entry, On Exit, Do en On Event).

Statechart Diagram van een Class maken

Navigeer naar de betreffende Class in de browser en selecteer deze - rechter muisklik > New >
Statechart Diagram
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Ga naar de Class Diagram door op het plusje voor Logical View te klikken en vervolgens te

dubbelblikken op Main.

Er zal een scherm verschijnen waar de onderstaande weergaven een deel van is, mochten er iconen
ontbreken in de werkblak kan deze (indien nodig) via rechter muisklik op de werkbalk - Customize
worden aangepast. Je zult hier zien dat er nog meer toegevoegd kan worden, maar de onderstaande
zijn de belangrijkste, waarschijnlijk zul je van de onderstaande set niet alles nodig hebben.

D+ BB g 2 0|
L AN

B [upitled)

I1ze Caze View
/07 Logical Yiew
- I ain
#-E NewClass?
----- B <oweb Himl Formz > MewClas
----- - Mewlnterface
3 Associations
F-CJ Component Yisw
----- Deployment Wiew
--{#g] Model Properties

I S B S 12 11 T

-

0;

Browser

Selection Tool

Text Box

Note

Anchor Note to Item

Class

Parameterized Class

Class Utility

Parameterized Class Utitity
Association
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Voor het toevoegen van bv. een Class klik je deze aan op de werkbalk en vervolgens klik je op de
plaats waar deze in het diagram moet komen, vervolgens kun je de naam invoeren.

Voor het toevoegen van een associatie (bv. Association, Aggregation etc) klik je deze aan op de
werkbalk en vervolgens klik je op de zender (bv.de Class) en trek je naar de ontvanger (bv. een ander

Class).

Hieronder volgen stappen om enkel hoofdattributen van een Class Diagram te verfijnen.

Class

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Class, deze in de diagram - rechter
muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte documentatie

worden getyped.
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Veranderen stereotype

Je kunt een van de gewonen Class omzetten naar bv. een Business Class. Selecteer hiervoor de
betreffende Assocation in de diagram - rechter muisklik > Open Specifiation vervolgens kan bij
Stereotype de juiste stereotype worden gekozen.

Operations toevoegen

Selecteer, voor het toevoegen van Operations aan een Class, deze in de diagram - rechter muisklik
- Open Specification hierna klik je op het tabblad Operations, vervolgens rechter muisklik op het witte
vlak = Insert, je kunt dan de naam invoeren.

Om Preconditions voor de Operation in te voeren rechter muisklik op de Operation &> Specification...
- tabblad Preconditions.

Bij het tabblad General in dit scherm kun je selecteren of de Operation; Public, Protected, Private of
Implementation is.

Attributes toevoegen

Selecteer, voor het toevoegen van Attributes aan een Class, deze in de diagram -> rechter muisklik >
Open Specification hierna klik je op het tabblad Attributes, vervolgens rechter muisklik op het witte
vlak > Insert, je kunt dan de naam invoeren. Als je het type attribute wil instellen of de Initial Value wil
instellen selecteer dan het betreffende attribuut, vervolgens rechter muisklik > Specification....Hier
kun het type instellen (Boolean, Integer, String etc) en een Initial Value invoeren.

Operation Signature zichtbaar maken

Selecteer, voor het zichtbaar maken van de Operation Signature, de betreffende Class in het diagram
- rechter muisklik > Options > Show Operation Signature.

Associatie

Cardinaliteit aanpassen

Selecteer de associatie (bv. een toegevoegde Aggregatie) = rechter muisklik > Open Specificaties >
klik op het tabblad voor de betreffende rol (Role A Detail of Role B Detail) > Slecteer de Multiplicity.

Hoe voeg je een Compositie toe?

Voeg een Aggregatie toe > Open Specificaties - tabblad Role B Detail > By Value aanvinken in
plaats van Unspecified.
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Sequence Diagram

Ratlonal@

Rose 2000

Voor het maken van een Sequence Diagram klik op Browse (boven in de menubalk) > Interaction
Diagram > Selecteer in de linker kolom de view waar de diagram bij hoort (waarschijnlijk is dit de
Logical view) > Voer de naam in en controleer of Sequence is geselecteerd > klik ok

Er zal een scherm verschijnen waar de onderstaande weergaven een deel van is, mochten er iconen
ontbreken in de werkblak kan deze (indien nodig) via rechter muisklik op de werkbalk - Customize
worden aangepast. Je zult hier zien dat er nog meer toegevoegd kan worden, maar de onderstaande
zijn de belangrijkste, waarschijnlijk zul je van de onderstaande set niet alles nodig hebben.

D d| =88 2 80|
L ~N
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: b ain

_—>_>} Azsociations
MewDiagram
; -[C7 Component View

{28 Model Properties

Selection Tool

Text Box

Note

Anchor Note to Item
Object

Object Message
Message to Self

Destruction Marker

Precedure Call
Asynchronous Message

Return Message

Browser

Voor het toevoegen van een Obiject klik je deze aan op de werkbalk en vervolgens klik je op de plaats
waar deze in het diagram moet komen.

Voor het toevoegen van een message (bv. Asynchronous Message, etc, maar niet de Message to Self
en de Distruction Marker) klik je deze aan op de werkbalk en vervolgens klik je op de zender (bv.de
Object) en trek je naar de ontvanger (bv. een ander Object).

Voor het toevoegen van de Message to Self en de Destruction Marker klik je deze aan op de werkbalk
en dan klik je op de plek op de Life Line (stippel lijn onder een object) van het Object.

Hieronder volgen stappen om enkel hoofdattributen van een Sequence Diagram te verfijnen.

Object

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Class, deze in de diagram = rechter
muisklik © Open Specification hierna kan onderin het nu verschenen scherm een korte documentatie
worden getyped.

Class van de object instellen (tevens om object in Actor te veranderen)

Selecteer, voor het wijzige van de Class, het object in de diagram > rechter muisklik > Open
Specification - selecteer bij Class de juiste classe.
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Naam toevoegen

Selecteer, voor het toevoegen van een naam aan de Class, deze in de diagram - rechter muisklik >
Open Specification - voer bij Name de juiste naam in.

Focus of Control aanpassen

Om de Focus of Control (rode blokken die op de Life Line verschijnen als er een message aanzit) aan
te passen (bv. om van twee Focus of Controls een grote te maken) selecteer je deze > alt toets
ingedrukt houden - linker muisknop ingedrukt houden - Focus of Control naar beneden trekken >
alt toets en muisknop loslaten.

Messages

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Message, deze in de diagram >
rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.

Type Message wijzigen

Selecteer, voor het wijzigen van het type van een Message, deze in het diagram - rechter muisklik >
Open Specificatioen - Tabblad Detail > Selecteer het juiste type voor de Message.

Frequency van een Message wijzigen

Selecteer, voor het wijzigen van de Frequency van een Message, deze in het diagram - rechter
muisklik > Open Specificatioen - Tabblad Detail > Selecteer de juiste Frequency voor de Message.

Operatie keizen

Selecteer, voor het keizen van de bijbehorende operatie, de Message in het diagram - rechter
muisklik > Open Specificatioen - selecteer bij Name de juiste operatie.

Sequence diagram omzetten naar Collaboratie diagram

Om van een Sequence diagram een Collaboratie diagram te maken (of de Collaboratie diagram
bijwerken vanuit de Sequence diagram) open je het Sequence diagram en druk je op 75.
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Collaboration Diagram

Voor het maken van een Collaboration Diagram klik op Browse (boven in de menubalk > Interaction
Diagram > Selecteer in de linker kolom de view waar de diagram bij hoort (waarschijnlijk is dit de
Logical view) > Voer de naam in en controleer of Collaboration is geselecteerd > klik ok

Er zal een scherm verschijnen waar de onderstaande weergaven een deel van is, mochten er iconen
ontbreken in de werkblak kan deze (indien nodig) via rechter muisklik op de werkbalk - Customize
worden aangepast. Je zult hier zien dat er nog meer toegevoegd kan worden, maar de onderstaande
zijn de belangrijkste, waarschijnlijk zul je van de onderstaande set niet alles nodig hebben.
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Voor het toevoegen van een Object of Class Instance klik je deze aan op de werkbalk en vervolgens
klik je op de plaats waar deze in het diagram moet komen.

Voor het toevoegen van een Link of (maar niet de Link to Self) klik je deze aan op de werkbalk en
vervolgens klik je op de zender (bv.de Object) en trek je naar de ontvanger (bv. een ander Object).
Voor het toevoegen van de Link to Self klik je deze aan op de werkbalk en vervolgens klik je op het
object waar deze bijhoort.

Om van een gewonen Link of Link to Self een (Reverse) Link Message te maken klik je deze aan op
de werkbalk en klik je vervolgens de betreffende.

Om aan een (Reverse) Link Message een (Reverse) Data Token toe te voegen klik je deze aan op de
werkbalk en vervolgens klik je op de (Reverse) Link Message.

Hieronder volgen stappen om enkel hoofdattributen van een Collaboratie Diagram te verfijnen.

Object

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Object, deze in de diagram >
rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.
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Classes selecteren

Selecteer, voor het selecteren van de Class van het Object, deze in de diagram - rechter muisklik >
Open Specification hierna kan je bij Class de classe selecteren.

Naam invoeren

Selecteer, voor het invoeren van de Naam van het Object, deze in de diagram - rechter muisklik >
Open Specification hierna kan je bij Name de naam invoeren.

Persistence instellen

Selecteer, voor het instellen van de Persistence van het Object, deze in de diagram - rechter
muisklik > Open Specification hierna kan je bij Persistence de persistence invoeren.

Van een Object Multiple Instances maken

Selecteer, voor het Multiple Instances maken van een Object, deze in de diagram - rechter muisklik
- Open Specification hierna kan je Multiple Instance aanvinken.

Class Instance

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de Class Instance, deze in de diagram
- rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.

Classes selecteren

Selecteer, voor het selecteren van de Class van de Class Instance, deze in de diagram - rechter
muisklik > Open Specification hierna kan je bij Class de class selecteren.

Naam invoeren

Selecteer, voor het invoeren van de Naam van de Class Instance, deze in de diagram - rechter
muisklik > Open Specification hierna kan je bij Name de naam invoeren.

Object Link/Link to Self

Associatie van de Link selecteren (niet bij Link to Self)

Selecteer, voor het selecteren van de Associatie van de Object Link, deze in de diagram - rechter
muisklik > Open Specification hierna kan je bij Assoc de associatie selecteren.
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Naam toevoegen

Selecteer, voor het toevoegen van de Naam van de Link, deze in de diagram - rechter muisklik >
Open Specification - voer bij Name de juiste naam in.

Visibility selecteren

Selecteer, voor het selecteren van de Visibility van de Link, deze in de diagram - rechter muisklik >
Open Specification - hierna kun je bij (Supplier/Client) visibility de visibility selecteren.

Van een Link een Shared Link maken

Selecteer, voor het maken van een Shared Objectvan een object, deze in de diagram > rechter
muisklik > Open Specification hierna kan je Shared aanvinken.

Toevoegen van meerdere Links to Self

Als je een tweede Link to Self toevoegt zie je er maar een, maar er zijn er echt twee. Om dit zichtbaar
te maken rechter muisklik je op de Link > Position > selecteer dan Top, Bottom, Left of Right.

(Reverse) Link Message

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van de (Reverse) Link Message, deze in de
diagram - rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een
korte documentatie worden getyped.

Type (Reverse) Link Message wijzigen

Selecteer, voor het wijzigen van het type van een (Reverse) Link Message, deze in het diagram >
rechter muisklik > Open Specificatioen > Tabblad Detail > Selecteer het juiste type voor de
Message.

Frequency van een (Reverse) Link Message wijzigen

Selecteer, voor het wijzigen van de Frequency van een (Reverse) Link Message, deze in het diagram
-> rechter muisklik > Open Specificatioen > Tabblad Detail > Selecteer de juiste Frequency voor de
Message.

Operatie keizen

Selecteer, voor het keizen van de bijbehorende operatie, de (Reverse) Link Message in het diagram
-> rechter muisklik > Open Specificatioen - selecteer bij Name de juiste operatie.
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Collaboratie diagram omzetten naar Sequence diagram

Om van een Collaboratie diagram een Sequence diagram te maken (of de Sequence diagram
bijwerken vanuit de Collaboratie diagram) open je het Collaboratie diagram en druk je op 5.
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Packages

Met de voorgaande kennis ben je in staat om een simpel programma te ontwerpen in Rose, echter wat
te doen als het programma niet uit één deel (bv. form met code) maar uit meerdere delen (bv. 2 forms
met code) zal bestaan? Dit hoofdstuk zal deze vraag beantwoorden.

Creéren van een Package

Navigeer in de browser naar Logical View en selecteer deze - rechter muisklik > New - Package.
Geef de Package een duidelijk naam (bv. <<Form>> Klant toevoegen, <<GUI>> Hoofdmenu of
<<Unit>> Algoritmes). Duid tussen de haakjes (<< en >>) aan welk soort deel van het programma
deze Packages betreft.

Diagrammen maken in een Package
Selecteer de Package - rechter muisklik > New - selecteer het betreffende diagram.
Mocht er een Use-Case voor deze Package nodig zijn (bv. bij een Form), zet deze dan ook in de

Package, doe dit met alle diagrammen die je nodig acht.
Je kunt ook eerder gemaakte diagrammen in de Package slepen om ze er in te zetten.
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Component Diagram

Ga naar de Component Diagram door op het plusje voor Component View te klikken en vervolgens te
dubbelblikken op Main.

Er zal een scherm verschijnen waar de onderstaande weergaven een deel van is, mochten er iconen
ontbreken in de werkblak kan deze (indien nodig) via rechter muisklik op de werkbalk - Customize
worden aangepast. Je zult hier zien dat er nog meer toegevoegd kan worden, maar de onderstaande
zijn de belangrijkste, waarschijnlijk zul je van de onderstaande set niet alles nodig hebben.
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Broner

Voor het toevoegen van alle attributen (behalve Dependency) klik je het betreffende attribuut aan en
vervolgens klik je op de betreffende plaats in de diagram.

Voor het toevoegen van een Dependency klik je deze aan in de werkbalk en vervolgens klik je op het
zendende attribuut dan sleep je naar het vervangende attribuut.

Hieronder volgen stappen om enkel hoofdattributen van een Component Diagram te verfijnen.

Alle attributen (behalve Package en Dependency)

Korte beschrijving toevoegen

Selecteer, voor het toevoegen van een korte beschrijving van het attribuut, deze in de diagram >
rechter muisklik > Open Specification hierna kan onderin het nu verschenen scherm een korte
documentatie worden getyped.
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Taal instellen

Selecteer, voor het instellen van de taal van het attribuut, deze in de diagram - rechter muisklik >
Open Specification hierna kun je bij Language de taal instellen (bv. C++, Visual Basic, Delphi (alleen
als Rose Delphi Link is geinstalleerd) etc) instellen.

Mocht een van de talen niet te kiezen zijn of niet bij Tools (boven in de menubalk) staan, klik dan Add-
Ins &> Add-In manager... - vink het hokje voor de betreffende taal aan (voor Delphi moet de Rose
Delphi Link geinstalleerd zijn). Ook kun je hier andere Add-Ins selecteren.

Stereotype instellen

Selecteer, voor het instellen van het stereotype van het attribuut, deze in de diagram - rechter
muisklik > Open Specification hierna kun je bij Stereotype het stereotype (bv. DLL, Applet, Database,
Main Program etc) instellen.

Attribuut aan een Class koppelen

Selecteer, voor het koppelen van een Attribuut aan een Class, deze in de browser > sleep deze met

de linker muisknop ingedrukt naar de betreffende Class - laat de muisknop los, je zult de Class naam
zien veranderen.
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Controleren van het ontwerp

Homogeniseren

Tijdens het ontwerp proces (vooral is dit gebeurd door min of meer onafhankelijk opererende
(groepjes) ontwerpers) is het belangrijk dat het ontworpen model homogeen (ho-mo-geen (bn.) 1 van
dezelfde aard of samenstelling => gelijksoortig; <=> heterogeen 1) wordt gehouden. Ontwerpers
kunnen schrijf fouten maken of andere woorden gebruiken om hetzelfde aan te duiden, ook worden
Classes gecombineerd, gesplitst en verwijderd. Hierdoor komt de homogeniteit van het ontwerp in
gevaar, daarom is het belangrijk dat de verschillende (groepjes) ontwerpers communiceren over het
ontwerp.

Combineren van Classes

Omdat er door verschillende (groepjes) ontwerpers aan verschillende scenario’s (lees
Sequence/Collaboration Diagrams) wordt gewerkt, kunnen dezelfde Classes verschillende namen
hebben. Door door het model heen te lopen kun je controleren of Classes het zelfde zijn, let daar bij
op de definitie en de operaties en attributen. Als je er van overtuigd bent dat twee Classes hetzelfde
doen, dan kun je de Class kiezen met de beste naam.

Splitsen van een Class

Classes moeten de gouden regel van OO volgen; Hij moet één ding doen en hij moet het heel goed
doen. Een Class die bijvoorbeeld persoonsinformatie bijhoudt en bijhoudt aan welke projecten
iemand (heeft) gewerkt doet te veel, dit kan beter gemodelleerd worden als een Class met
persoonsinformatie en een Class met de projectinformatie, met daartussen een associatie.

Als je dus een Class hebt die te veel doen dan moet je ze splitsen in twee (of misschien zelfs meer)
Classes.

Verwijderen van een Class

Een Class kan geélimineerd worden van je model als: De Class geen structuur of gedrag heeft.

De Class niet meedoet in een Use-Case.
Controleer vooral je Control Classes, als deze bijvoorbeeld enkel dienen als doorgeef luik tussen een
Boundary Class en een Entity Class zonder dat er Sequence logica nodig is.

Check model

Als je model Homogeen is kun je daarna testen of je model wel syntactisch voldoet aan de eisen van
UML (bv. geen operaties in de Sequence Diagram gebruiken die niet bij de betreffende Class horen),
dit doe je door te klikken op Tools (boven in de menubalk) - Check Model. Hierna verschijnen in de
Log errors (als deze er zijn), zie je de Log niet klik dan op View (boven in de menubalk) > Log.

' Bron: www.vanDale.nl
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Van ontwerp naar documentatie

Layout Diagram

Na het maken van diagrammen ben je vast niet te vrede over het uiterlijk ervan, lijnen die elkaar
snijden, later toegevoegde componenten die er een beetje verloren bijhangen etc. In plaats van alles
met de hand te gaan schuiven totdat alles goed staat kun je dat ook makkelijker doen.

Klik op Format (boven in de menubalk) = Layout Diagram.

Kopiéren van diagrammen naar MsWord

Navigeer en open het diagram dat je wil kopiéren - zorg dat er geen attribuut geselecteerd is >
CTRL+C - ga naar de plaats waar de diagram in het MsWord document moet komen te staan >
CTRL+V

Zorg wel dat de diagram beschikt over de in het hoofdstuk “Belangrijk lees dit eerst voordat je een
diagram maakt!” besproken Note.

BELANGRIJK: DOCUMENTATIE MET DIAGRAMMEN
ZONDER DEZE NOTE WORDEN NIET
GEACCEPTEERD!!!

WERK DE NOTE NA IEDERE
VERANDERING BIJ!!!
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Forward Engineering

Met Forward Engineering heb je een krachtig hulp middel om je ontwerp om te zetten in een
implementatie aanzet, of om je al bestaande implementatie bij te werken vanuit het ontwerp.

Mocht een van de talen niet te kiezen zijn of niet bij Tools (boven in de menubalk) staan, klik dan Add-
Ins > Add-In manager... = vink het hokje voor de betreffende taal aan (voor Delphi moet de Rose
Delphi Link geinstalleerd zijn). Ook kun je hier andere Add-Ins selecteren.

Delphi
Alleen beschikbaar als de Rose Delphi Link is geinstalleerd.

Zorg dat de taal van de Attributen op Delphi staat (zie het hoofdstuk Component Diagram), zorg ook
dat de Classes aan de juiste componenten zijn gekoppeld (zie het hoofdstuk Component Diagram).
Klik Tools > Ensamble Code - Rose Delphi Link - Open of creéer een nieuw project in Rose Delphi
Link (File (boven in de menubalk) > klik Update All aan de rechterkant (die naar het Delphi project
wijst).

C++

Zorg dat de taal van de Attributen op C++ staat (zie het hoofdstuk Component Diagram), zorg ook dat
de Classes aan de juiste componenten zijn gekoppeld (zie ook het hoofdstuk Component Diagram).
Selecteer de Component - rechter muisklik > C++ - Code Generation.

De gegenereerde code komt in de directory waar Rose is geinstalleerd, onder C++\Source.

Visual C++

Zorg dat de taal van de Attributen op Visual C++ staat (zie het hoofdstuk Component Diagram), zorg
ook dat de Classes aan de juiste componenten zijn gekoppeld (zie het hoofdstuk Component
Diagram).

Selecteer een van je Classes = Tools (boven in de menubalk) > Visual C++ > Model Assistant. Hier
kun je de zogenaamde Code Generation Properties instellen, hier kun je de Class Operaties zoals
Constructors en Destructors.

Selecteer een Component waarvan je de code wil genereren - rechter muisklik > Update Code. Volg
dan de stappen.

Visual Basic

Zorg dat de taal van de Attributen op Visual Basic staat (zie het hoofdstuk Component Diagram), zorg
ook dat de Classes aan de juiste componenten zijn gekoppeld (zie ook het hoofdstuk Component
Diagram).

Selecteer een van je Classes - Tools (boven in de menubalk) > Visual Basic > Model Assistant.
Hier kun je de zogenaamde Code Generation Properties instellen, hier kun je de zogenaamde Get,
Set en Let procedures voor de Class procedures en associaties creéren, ook kun je Constants,
Declare Statements, Event Statements, Enum, Type Declarations, Properties, Methods en Method
Parameters creéren en specificeren.

Selecteer een Component waarvan je de code wil genereren - rechter muisklik > Update Code. Volg
dan de stappen.
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Reverse Engineering

Met Reverse Engineering heb je een krachtig hulp middel om te controleren of je ontwerp en
implementatie nog over een stemmen of om je ontwerp bij te werken vanuit je implementatie.

Mocht een van de talen niet te kiezen zijn of niet bij Tools (boven in de menubalk) staan, klik dan Add-
Ins > Add-In manager... > vink het hokje voor de betreffende taal aan (voor Delphi moet de Rose
Delphi Link geinstalleerd zijn). Ook kun je hier andere Add-Ins selecteren.

Delphi
Alleen beschikbaar als de Rose Delphi Link is geinstalleerd.

Start een nieuw model, klik op Cancel kies geen framework. Klik op Tools (boven in de menubalk) >

Ensemble Tools - Rose Delphi Link. Rose Delphi Link wordt geopend, hier in klik je op File (boven in
de menubalk) > Open Project. Navigeer naar je project en open het, vervolgens klik je op de Update

All aan de linkerkant (die die naar de model kant wijst), hierna is het model gecreéerd en kun je Rose
Delphi Link sluiten.

Je kunt hetzelfde doen als je in plaats van een lege module de module opent waaruit je een project
hebt gecreéerd, zodat je deze bijwerkt.

C++

Open de Rational Rose C++ Analyzer (dit is een apart programma) - File > New - klik Caption >
voor de naam in die je wil geven - Klik Directories en navigeer naar de juiste directory, klik hier op
Add Current, AddSubdirs en Add Hierarcy - klik Extensions en voeg de extensies toe die de files
mogen hebben - klik op files en voeg de juiste files toe > F3 (Analyze) > F8 (Export to Rose) >
browse naar het model waar naar je wil Reverse Engineren - klik Ok.

Visual C++

Open je oorspronkelijke model (of zet een Component in de Component Diagram en zet de taal op
VC++ (zie het hoofdstuk Component Diagram)) - selecteer een Component - rechter muisklik >
Update Model - en volg de stappen (in het geval van een blanco model moet je tijdens deze stappen
ook het betreffende project openen).

Visual Basic

Open je oorspronkelijke model (of zet een Component in de Component Diagram en zet de taal op
Visual Basic (zie het hoofdstuk Component Diagram)) > selecteer een Component - rechter muisklik
- Update Model - en volg de stappen (in het geval van een blanco model moet je in het scherm
Select Components and Classes het project selecteren, selecteer de Component - rechter muisklik
- Properties > klik op de button met de ... > navigeer en open je project).
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Add-In manager 22; 25; 26
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Applet 22
Arguments 11
Assoc 18
Associatie 3;14; 18
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Asynchronous Message 15
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Attributes 14

B
Boolean 14
Browse 15; 17
Browser 8;10; 13; 15; 17; 21
By Value 14

C
C++ 6; 22; 25; 26
Cardinaliteit 14
Check model 23

Class 3; 6; 8; 12; 13; 14; 15; 16; 17; 18; 22; 23;
25

Class Diagram 13
Class Instance 17; 18
Class Operatie 25
Class Utility 8;13
Classes 5; 18; 23; 25; 26
Code Generation Properties 25
Collaboration Diagram 17; 23
Combineren 23
Component 21; 25; 26
Component Diagram 21; 25; 26
Component View 21
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Constructor 25
Control Classes 5;23
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D

Data Token 17
Database 21; 22
Decision 10
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Delphi Framework 5
Dependency 8; 13; 21
Dependency of Instantiates 8;13
Destruction Marker 15
Destructor 25
Detail 11; 14; 16; 19
DLL 22

Documentatie 7;9; 11; 12; 13; 15; 16; 17; 18;
19; 21; 24
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EJB 5
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Ensemble Tools 26
Enum 25
Errors 23
Event 11;12; 25
Event Statement 25
Extend Use-Case 8
Extensions 26
F
Focus of Control 16
Font 7
Format 7: 24
Forms 5; 20
Forward Engineering 25
Framework 5; 6; 26
Frequency 3; 16; 19
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Generalization 8:13
Generic Package 21
Generic Subprogram 21
Get 25
Guard Condition 11
H
Homogeen 23
Homogeniseren 23
Homogeniteit 23
Horizontal Synchronization 10
|
Implementatie 25; 26
Implementation 14
Include Use-Case 8
Initial Value 14
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Interface 8
J
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J2SE 5
JAVA 5;6; 26
JDK 5,6
JFC 6
K

Korte beschrijving 3; 9; 11; 12; 13; 15; 16; 17;
18; 19; 21

L
Layout Diagram 24
Let 25
Life Line 15; 16
Link Message 17,19
Link to Self 17;18; 19
Log 23
Logical View 10; 13; 20
M
Main 8;13; 21
Main Program 21; 22
Message to Self 15
Messages 5; 16
Method 25
Method Parameter 25
MFC 6
MsWord 7;9; 24
Multiple Instance 18
Multiple Instances 18
Multiplicity 14
N
Naam 3; 16; 18; 19
Name 16; 18; 19
Note 7:8;10; 13; 15;17; 21; 24
(0]
Object 3;10; 15;17; 18; 19
Object Flow 10
Object Link 17; 18
Object Message 15
Ontwerp 23; 24; 25; 26
Ontwerpers 23

Open Specification  9; 11; 12; 13; 14; 15; 16;

17;18; 19; 21; 22

Operatie 3;16; 19
Operation Signature 14
Operations 14
Oracle8 Datatypes 6
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Parameterized Class Utitity 8;13
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Precedure Call 15
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Propertie 25; 26
Protected 14
Public 14

R
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Realize 8
Refine Use-Case 8
Return Message 15
Reverse Data Token 17
Reverse Engineering 26
Reverse Link Message 17
Role A 14
Role A Detail 14
Role B 14
Role B Detail 14
Rose Delphi Link 5; 22; 25; 26

S
Selection Tool 8;13; 15; 17; 21
Send Arguments 11
Send Event 11
Send Targets 11
Sequence 3; 15; 16; 19; 23
Sequence Diagram 15; 23
Set 25
Shared 19
Shared Link 19

Specification 9; 11; 12; 13; 14; 15; 16; 17; 18;
19; 21; 22

Splitsen 23
Start State 10; 12
State 10; 11; 12
State Diagram 10
State Transition 10; 11
Statechart Diagram 10
Stereotype 9; 14; 22
String 14
Subprogram Body 21
Subprogram Specification 21
Swimlane 10; 11; 12
Synchronization 10
T

Task Body 21
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Type Declaration 25
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Undirectional Aggregation 8; 13
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Update All 25; 26
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